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1. SOFTWARE LICENSE AGREEMENT

1.1 Acknowledgement

At Securit World, we are committed to design and develop the highest quality
software and services.

We would like to thank all the people who have contributed their talent, intellect and
heart to produce this product.

1.2 Copyright

Information in this document is subject to change without prior notice and does not
represent a commitment on the part of Securit World. The software, which includes
information contained in any databases, described in this document is furnished under
a license agreement or nondisclosure agreement and may be used or copied only in
accordance with the terms of that agreement. It is against the law to copy the software
except as specifically allowed in the license or nondisclosure agreement. No part of
this manual may be reproduced in any form by any means, electronically or
mechanical, including photocopying and recording, for any purpose without the
written permission of Securit World Ltd.

© 1993-2002 Securit World Ltd., all rights reserved.

1.3 Trademarks

BadgeMaker, Securit 500, Securit 5000, Securit 5400, Securit 5500, Securit 6000,
BM, DBLC, BC etc. are trademarks of Securit World Ltd.

Windows is a trademark of Microsoft Corporation. All other trademarks are the
property of their respective holders and are hereby acknowledged.

1.4 System requirements

BM6000 requires Microsoft Windows 95/98, NT4.0 or higher to run and can be used
on any IBM compatible computer that meets the following minimum requirements:

e Pentium 233 MHz Processor or better;
e 540 Mb Hard Disk or bigger;
e 64 Mb Internal memory or more;

o SVGA 800x600, 64K colours.
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2. THE CARD DESIGN MODULE (BADGECREATOR)

From the ‘Card details’ window the card design module can be accessed. Clicking the
‘Layout’ button can do this. The following dialogue will be displayed:

E_E BadgeCreator - [STAND-ALDNE.BM [Untitled] ]
File Edt %iew Options Help

EREE RO EEZEECNEEE

A
| | | /

From this dialogue all options are available to create a card layout. Most of them can
be accessed easily by clicking a button on the toolbar. The following options are
available in the toolbar:

| 0[E] o] alAlxdR@ @ &/ oo olalel
E Open layout Open an existing layout
E New Layout Create a new layout
ﬁ Save Layout Save the current layout

ol Undo Undo the last action
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Lock items

Add text

Add data

y |m =

Add logo

Add image

Add line

Add rectangle

Add circle

Add barcode

Front/back

Zoom in

o2 e 1o o N

Zoom out

Lock items from moving them by mouse

Add static text

Add dynamic text (from a database field)

Add a logo

Add an image to the layout

Add a line

Add a rectrangle to the layout

Add a circle

Add a dynamic barcode to the layout

Switch between the front and back of the card

Zoom in on the badge

Zoom out from the badge

In the following paragraph, these options will be described more detailed. The options
that are not accessible through the buttonbar will also be described.
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2.1 Creating a new layout

Select ‘New Layout’ from the ‘File’ menu to create a new layout. The following
dialogue will be presented:

Eﬁ Mew Badge Layout EHE |

Lapout | Paper I

M ame

|L|:|_I,Ialt_l,l card

[ Include Back Side

B ackground Color Front | |
Blackaraumnd [Ealon Bashk | |

M agnetic Stipe Pozitioning IND v|
Chip Positioning IND "l

Chip bype: I v|

Mumber of ping: I v|

] 4 | Cancel |

2.1.1 The ‘layout’ tab

Under ‘Name’ you can give in a short description of the layout. This name will be
presented in the layout selection dialogue box when printing a card.

When you check the option ‘Include Back Side’ you can create a double-sided
layout. For the back of the card, you have the same options as for the front (text,
logos, barcode, photos etc.). Only use this option if your printer supports double-sided
printing. If your printer does not support double-sided printing and you would like to
print the back of the card too, you have to create a separate (single-sided) layout and
print the back separately.

When you click ‘Background Color Front’ you will get the Windows color selection
dialogue to select a color as a background for the front.

The option ‘Background Color Back’ is only available if you create a double-sided
layout.

When you activate the option ‘Magnetic Stripe Positioning’ a black stripe will be
displayed on the back of a double side ISO format layout to indicate the place of the
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magstripe on the card. You can select ‘Top/Right’ or ‘Bottom/Left’. The option ‘Chip
Positioning’ does the same for the chip, with the difference that for the chip you can
select if you want the chip position on the front or the back. Furthermore, you can
select the chip type and the number of pins of the chip.

2.1.2 The Paper tab

i Mew Badge Layout EHE3 |

Layout [Paper]|
Type
|150-Card 85/54.5 =
— Orientation = Badaes penFage
" Paitrait Calumims |1 %

& Landscape

Fh:uwsl'l %

Measurement unitz in milimeters

= SHEE = Header ard Eoater

widh [26 [ = Header Heighl]D =
Height|54e5 = Eu:u:uterHeightIEl =

= Engitie

e
Top |'3'_@

Roht]o =
Eh:uttu:umlﬂ %

T Spane BEHVEE

Colurnnz |1 1] %

HDWS|1D %

)4 | Cancel |

Under ‘type’ you can select the card format. The format ISO-Card 86/54.5 is the most
current one. If your printer cannot print an ISO card from edge to edge (full bleed),
you can select another type, or give in the printable area of the card for the type
‘manual size’. If you want to print the information from more than one record on a
sheet of paper, you can use the A4 option (record/picture book). Depending on the
number of columns and rows the sheet will be divided in parts of the same size.

Click ‘OK’ if the information is filled in correctly. Now you will come in the card
design window.

Photo Gallery option

When you use A4 as badge type, it is possible to create a photo gallery. On one sheet
you can print several photos. The number of photos you can print on one sheet is the
product of the number of rows and the number of columns.
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A header and footer can be added to give the photo gallery a name. Note that for the
header and footer only static data can be used.

LTE BadgeCreator - [STAND-ALONE.BM [Untitled.) ]
Fil= Edit View Option: Help

ELEIERNEEEEEREEE EETEY |
1 2 3 4565 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21

LI

Photo Gallery

W W~ N R W N =

MM RN N M M RN RN = =i - -k ad =i =i =k -d -
= O N & W N = O O @0 ~N & " & W N = O

n
@

BM&6000

na
o

20

minl I

| Layaut Mame: Layalty badge i

| 239¥33 | 146/32 | Fontside



il

=4

ID SYSTEMS

2.2 The card design window

When the general card settings have been created, you enter the card design window:

g BadgeCreator - [STAND-ALOME BM [Untitled.] ]
File Edit “iew Option: Help
SD|d o alAlgld@e« oo olale)
1 2 3 4 5 6 7 8 £
IIIIIIIII|IIIIIIIII|IIIIII||||IIIIIIIII|IIIIIIIII|IIII||||||IIIIIIIII|IIIIIIIII|IIII|||||
3 5
E r—
1-
2
33
4
5
= -
s 2|
|La_l,u:|ut Mame: Loyalty badge i
| | B57/17 | Fiontsid

The selected card format will be visible in this window. On the horizontal and vertical
axis the size of the card is displayed in centimeters. You can zoom in or out on the
layout by using the Shift F11 or Shift F12 key combination or by clicking the zoom
buttons on the right of the button bar.

Lock items

This option can be found in the ‘Edit menu’ and in the button bar. You can use it to
lock the position of the items on the badge. This will prevent the items from moving
when you click on them and move the mouse by mistake. It will remain possible to
reposition them by double clicking and filling in other values on the position tab.

Undo

Use this option (from the ‘Edit menu’) to undo the last action. You can undo one
action.
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Tip: If you have to experiment a lot with different versions of the same layout, it is
best to save these different versions under another name (e.g. combination of the
name with a version number).

In this window you can add all (graphic) layout items. You can do so with the ‘Add’
option from the ‘Edit’ menu or by using the buttons in the toolbar.
Image

This option is meant for other image types than a photo that are linked to a record.

Static Text
Static text is a text you can add manually to your layout. It is fixed for every printed
card. When you use this option, the following dialogue will be displayed:

i Add Static Text Item ]|

Datal F'u:usiticunl Fu:untl

[Presz Control+Enter to create a new ling)

™ “word wrapping

Preview

o Text

(] I Cancel

Under ‘data’ you can replace ‘no text’ by the required fixed text. You can only enter
one line at a time. If you need more lines of text you can enable ‘word wrapping’
when the text does not fit on one line it will automatically continu on the next line
(depending on the size of the text box).

Under ‘position” you will find the following options:
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i| Data I Fant I

= start I'ID,EI "Width IED,E
' start I'I 0.0 Height I'IEI,EI

Layer IEI "I AutoSize |

Orientation I a ﬂ

[~ Clipping

Freview

ScreenCheck Loyalty Card

] Cancel

10
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Xstart: startposition of the text box on the X-axis in 10ths of a millimeter.

Ystart: startposition of the text box on the Y-axis in 10ths of a millimeter.

Width: width of the text box.

Height: height of the text box.

Layer: level on which the text item will be printed on the card. A layer with a higher
number will be printed on top of a layer with a lower number. Note that items on a
lower layer can become invisible

Orientation: texts can be rotated in steps of 90 degrees.

Clipping: If this option is enabled, text that does not fit into the text box will be
clipped. In that way you will be sure that no text will run out of the text box and be
mixed with other layout items. When you use italic texts or Arabic, it is advisable to
disable this option.

Under the ‘Font’ tab you will find the following options:

gl Edit Static Text Properties EE

F'u:usitiu:unl Data FDntl

ol |.-‘-‘-.ria| — Alighment
; I o+ Left
5 12

= 1 Center
Character Set [SHIFTJIS -  Right

—Effects———
ﬁl I~ Underlined
[~ Stike Out
Fort Baze

05

Preview

ScreenCheck Loyalty Card

ak. | Cancel

Font: Displays the Windows font dialogue.

Size: Size as selected in the font dialgue (or default value).

Character Set: Select the required character set to use for the chosen font. This can
be important if you want to use foreign characters.

Alignment: Chose to use left, center or right alignment.

Effects: Activate to underline or stike out the characters. Also you can select here the
fontbase (position of characters in respect of the lower side of the text box). Default
value is 1.5 (mm). Increase this value for bigger font sizes and decrease this value for
smaller font sizes.

Dynamic Text
The dialogue for adding dynamic text is very similar to the one for static text (font tab
and position tab are the same). The difference lies in the information tab. Here you

11
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don’t fill in static text, but you can select the database field of which information in

the layout is required. There are 20 fields available for the layout.

id Add Dynamic Text Item |

Datal F'u:usiticunl Fu:untl

IFIELD1

[~ wiord wrapping

Preview

FIELD1

Ok Cancel

After clicking the ‘Select Field’ button, a list with the available fields will be
displayed. These fields are numbered 1 till 20.

S R N |

Description Field M ame

Card Mumnber Fieldl =
M ame Fieldz |
Sumame Fielda

Businezs Mame Fieldd

Address 1 Field5s

Address 2 FieldE

Address 3 Field?

Telephone Mumber Fieldg

Fax Mumber Fieldd

Ermail Field10 -

Edit Diescription (] 4 Cancel

When you edit the layouts a lot, it is useful to give in a description for each field by
clicking the ‘Edit Description’ button.

Photo
When you add a photo the following dialogue will be displayed:

12
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Eﬂ.ﬁdd Photo ltem EE

Pogition |

#start 100 width 20 0

* start 1100 Heightl#lllil
Layer IU 'I

(] Cancel

You can select the start position (left top corner), the width and the layer on which
the photo will be printed. The photo has the normal width/height ratio for passport
photographs of 3/4. This means that you only have to give in the width, the height will
be adjusted automatically.

Signature
When you select this option the following dialogue will come up:

i Add Signature ltem H |

Pozition |

#start 1100 “whidth 40,0

i start I'IEI,EI Height |1 0.0
Layer ID vI

Ok Cancel

You can select the start position (left top corner), the width and the layer on which
the photo will be printed. The signature has a width/height ratio of 4/1, but this can be
changed by filling in other values for the width and height.

Logo
When you select this option the following dialogue will come up:

13
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Lowall.brmp

] 4 | Cancel |

In the ‘position’ tab you can give in the start position (left top of the logo), the width,
the height and the layer. Use scaling type to select whether you want the original size,
a free size or keep the aspect ratio.

You can find a logo by clicking the ‘Get Logo File’ button. The Windows ‘Open File
dialogue will be displayed. Select a logo file (in .bmp format) to add to the layout.

b

Note to save your logo files in the logos folder, otherwise you run the risk to
accidently delete your logo files from the harddisk. If an invalid reference to a logo
file exists in a layout, the layout symbol is displayed on the place where the logo
should be (in BC only).

Barcodes
With this option you can print a database field as barcode on the card. There are 21

different types available.

Use the ‘data’ tab to select a database field in the same way as for the ‘add database
field” option.

Use the ‘type’ tab to select a barcode and define the settings for it:

14
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F'u:nsitiu:nnl Data T}'I:'El

Bar Code Dersity |1—%
UPCE Height |1U %
EANAIANA3 hd =

Ear code Test Supplerment: |5 Drigit VI
Stretch factor |2 vI

Checksum I - I
‘Bar code Test' Font | Mod 10

|| || ooopo
O 42340 1 poooo 11112 ||

Under ‘Bar Code’ you will find a list with 21 available bar codes.

3 eloy

Prewview

(] Cancel

Under ‘Bar code Text’” you have the options ‘Off = no text at bar code’, ‘Above= text
above bar code’ or ‘Below= text below bar code’.

Use the ‘Bar code Text Font’ button to select a font for the text of the bar code.
Density: Use this option to select the density of the bar code. In sample in the lover
part of the dialogue, you can see the effect of changing the density.

Height: Use this option to adjust the height of the bars of the bar code.

Supplement: For some bar codes a supplement is available. Use this option to select
this supplement.

Ratio: Use this option to set the ratio between the thick and the thin bars. Available
choices are: 3:1, 2.5:1 and 2:1. The option ‘Ratio’ is not available for bar codes with a
supplement.

Stretch factor: In addition to the density we added this option to be more flexible on
the small space available on an ISO card. With this option you can change the density
more precisely. Because this option was added later, the effect is not visible in the
preview of the bar code dialogue. However it is visible in the preview of BM6000.

Line, rectangle, circle.

You can add these items to split up a layout in different sections, to emphasize
information or to create a coloured space on the layout. You can define the line
thickness and colour of these 3 elements. For a rectangle and a circle it is also possible
to fill the object with a colour.

15
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Calar | ¥ Salid
- Line Thickness
@1 i

(] | Cancel

Color: The default value for the colour is red. You can select other colours by
clicking the ‘Color’ button.

Solid: Select here if the space within the circle should be empty or filled up with the
same colour.

Line Thickness: Use this option to select the line thickness (only when the ‘solid’
option is not used).

16
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Under the ‘Position’ tab the following settings can be made:

28 Add Circle Item HE|

# centre |3|l|:| R adiusz |2|l|:|
Y centre |3|l|:|

Layer ID 'I

(] | Cancel

X /Y centre: Give in the coordinates of the middle of the circle.
Radius: Indicate the radius of the circle in 10" of a mm.
Layer: Use this option to select the layer for the circle.

2.3 Mouse options in BadgeCreator

In BadgeCreator an existing layout item can be selected by drawing the cursor on this
item and click one time with the left mouse button. A frame will be displayed around
the item. When you move the cursor within this frame, the item will be moved along
with the cursor. In the frame 8 small rectangles are displayed. When you draw the
cursor on top of one of these rectangles, you can change the size of the item by
keeping the left mouse button down and move the cursor.

When you double click on an item the edit dialogue for this item will be displayed.

When you click with the right mouse button on an item, the following menu will
come up:

Copy
Paste
Delete

Zoam |n
Zoon Dut

Edit Badge Layout

Stam e Eeference Line

This menu is a short cut to a selection of options from the dropdown menus.

17
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2.4 Saving the layout

When the layout is ready it can be stored by using the ‘Save’ option from the ‘File’
menu. When a new layout is saved, the ‘Save’ dialogue is identical to the ‘Save as’
dialogue:

Save File As HE
Save_in:l‘a Badges j ﬁl

“temp.be
Misc. b
Mophato. b

Photo. b

File name: CIUSTOMER CARD.BC Save I
Save as hupe: IBadgeEreatDr [*BC) j Cancel |
A

BadgeCreator will suggest the layout description as indicated in the card settings as
file name. You can change the file name, but we recommend to use the same name as
the layout name as well as the file name to prevent confusion (the layout name is used
in BM6000 to select the layout).

When you use the ‘Save’ option for an existing layout, no dialogue will come up. The
latest version of the layout will be saved under the existing name. If you want to save
an existing layout under another name (File|Save As), not only the file name but also
the layout name (Edit|Badge Layout) must be changed. Otherwise duplicate names
would appear in the layout selection list.

2.5 Removing an existing layout

The option ‘Remove Layout’ from the ‘File’ menu can be used to remove an existing
layout. New layouts don’t have to be removed. You can just exit BC or open another
layout without saving the newly created one. The removal goes in two steps. You will
be prompted first if you want to remove the layout from the project (the layout can be
linked again by importing it). Then you will be prompted to remove the layout file
from the hard disk. The file is now physically removed and cannot be retrieved
anymore.

2.6 The advanced options of BadgeCreator

In this chapter the more advanced options that cannot be accessed through the tool
buttons will be explained.

18
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2.6.1 Importing a layout

In BC a layout can be imported that was designed somewhere else (for example at
Securit World or on another BM6000 system) on conditon that the layout name does
not exist yet. In that case you will have to rename the existing layout first.

When you import a layout the following dialogue will come up:

Laak i |ﬁ Badges j El
~temp.bc
Misc.be

Hophato.be

Photo.be

File narme: || Open

Files of twpe: IBadgEEreatDr [*.BC) j Cancel |

&

Please select the layout you want to import. After selecting the file click ‘Open’. Now
you will be able to give in a new file name (or to select another folder if required) and
save the imported file.

2.6.2 Language Setup

In BadgeCreator you can use different languages by selecting ‘Language Setup from
the ‘File’ menu. The available languages will be displayed in the ‘Language Setup’
dialogue. Select the desired language and click ‘OK’. Close and restart BC to activate
the new language. By default the program will start in English.

2.6.3 Copying and pasting layout items

In BC it is possible to copy an item and paste it in the same layout (on both sides in
case of a dual sided layout).

This option is useful when you need one item more than once on the layout (e.g. on
both sides of the layout). Also if you want to take over the settings of another item,
you only need to change the field (or text) and the coordinates.

You can copy an item by selecting it. Thereupon you select ‘Copy’ from the Edit
menu. With the paste option you can paste the copied item into the layout. If you need
the item on the other side, first select the side and then select paste.

19
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2.6.4 Selecting an item

The most common way to select an item is to double click it with the mouse.
However, when layout items are situated close to another, or the item to be selected is
covered by an item on a higher layer, this sometimes is not possible. In that case you
can select the item using the option ‘Select item from list from the ‘Edit menu’. The
following dialogue will be displayed:

Select Item From Lizt |

Awailable Items

an Layer [

= Layer 1
[¢] Photo, BC_PHOTO_
[3] Dwynarmic Test
4

Dynamic: Text
Layer 2
Layer 3
Layper 4
Laper &
Laver B
Layer 7
Layer 8
Laper 3

Edit Item | ok | Cancel

The available layers are presented in a list. A ‘+ sign’ in front of a layer means there
are several items available on this layer.

Click on the ‘+’ to display these items (the ‘+’ changes in a °-°).

Click on the desired item and then the ‘OK’ button to select it. If you want to edit the
item, click on the item and then on the ‘Edit item’ button and then ‘OK’.

20



s :CURI

ID SYSTEMS

2.6.5 Zooming in and out

You can display the layout bigger or smaller on the screen by selecting ‘Zoom in’ or
‘Zoom out’ from the View menu. You can do this also directly by pressing ‘Shift F11°
for zooming in or ‘Shift F12’ for zooming out.

2.6.6 Select layout side

When you are creating or editing a double-sided layout, you can use the option
‘Layout Side’ from the view menu.

You can do this also with the change layout side button.

2.6.7 The system settings
After selecting ‘System settings’ from the ‘options’ menu the following dialogue will
be displayed:
i System Settings Options EHEI
Default Fant | Zoom and Grid I

Select Mew Font I — Alighment
Fort F o Left
o
{1 Center

Size I12 r" Hight
Shyle IHeguIar

—Effects———

Character Set ISHlFTJIS vI
[~ Underlined

[~ Shike Out
Font Basze

o

Prewview

’AaBchDd

Cancel |

The first tab is ‘default font’, used for selecting the default font of dynamic and static
text items or for seleting the default alignment (left, center, right) and effects
(underlined or strike out).

The Font Base is the space between the bottom of a letter and the bottom line of the
text box. This space is necessary for letters like ‘g’ and ‘p’. The default value is ‘1.5’
for a font size of 12.

21
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Under ‘Zoom and Grid’ you will find the following settings:

p_‘z_ﬂ System Settings Options

Default Font  Zoom and Grid
Zoom Factor
I 3 - I

[~ Snap Tao Giid
= | Sy Erid

Grid Reszalution [mm]:

1 -

Preview

’AaBchDd

Cancel |

The ‘Zoom Factor’ varies between 1 and 5. Increase this value to zoom in on the
layout. You can also zoom in and out by using the key combination Shift-F11 and
Shift-F12.

Snap to Grid: This option can be used for easy positioning with the mouse without
having to type in the exact coordinates. The start coordinate of an item will always be
placed on a dot of the grid. In this way an item can be positioned exactly under or next
to eachother.

Show Grid: When this option is checked the grid will be displayed. The option ‘Snap
to Grid’ is independent from the display of the grid. NB: The grid is displayed on the
background of the layout. If you put an item on the layout that covers the complete
surface of the card, the grid will not be visible anymore. When using the grid it is
recommended to start with the text items.

Grid Resolution: Define the grid resolution by giving in a value (in mm) for the
distance between the dots in the grid.

22
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2.6.8 Encode settings

Select encode settings from the ‘System’ menu to define if you want to use magstripe
and/or chip encoding.

gl Badoe Lapout Options BHE |

tagnetic Encoding | Chip Encu:u:lingl

v | Include

OF. | Cancel

When the ‘include magnetic encoding’ option is checked the application using
BM6000 will also encode the card when it is printed (if a card printer with magstripe
encode module is connected).

Click the ‘Advanced’ button to define:
o fill character: character used to fill up ‘empty’ positions

o fill to end: fill empty positions not only between items but also after last item
till end of track

e end tracks: define which tracks must be encoded

e Magicard options: special options for Magicard printers

gl Badge Layout Options EHE |

Magnetic Encoding |

[ Include

(] Cancel

When the ‘include chip encoding’ option is checked the application using BM6000
will also encode the card when it is printed (if a card printer with chip encode module
is connected).

NB: Do not forget to save the layout again after enabling the encode option.
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2.6.9 Reference line

Use this option to define a horizontal or vertical reference line. These lines can be
used to align items under or next to each other. This dialogue will be displayed:

Eﬁ Heference Line Options EHE

" Wertical

# Position IU,U

Alignment I Leit j

" Harizantal
' Position IU,U

Aligrirment I Top j

ak. | Cancel |
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For the vertical reference line you can define the x-coordinate and the alignment (the
left side, center or right side will be aligned on the reference line).

For the horizontal reference line you can define the y-coordinate and the alignment
(the top, center or bottom will be aligned on the reference line).

If you defined a reference line you can align an item by clicking on it with your right
mouse button and select ‘Snap to reference line’.

2.7 The Help menu

In the help menu you will find three options:

Help Index: Includes an overview of the available help items.
Help on help: Contains some general information how to work with help files.
About BadgeCreator: Displays information about the BC version number / license.

ifl About BadgeCreator... [ X] |

B adgeCreator G000

Iﬂ - Versiqn 419
[ s Copyright 20001 ScreenCheck B

Thiz copy iz licensed to;

Company: ScreenCheck By
Idzer: Eduard Duijrestin

Internet; v screencheck. com
E-rail: infof@screencheck, com
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